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イントロダクション 

Tecplot Chorus は CFD プロジェクト(結果の評価にツールによる複数のシミュレーションケースが必要なパラメ

トリックスタディなど) を管理する堅牢なフレームワークを提供します。システム性能の全体的な評価と単独の環境

で数十から数千というシミュレーションケースの視覚的な比較が可能で、これまで以上に確信を持った素早い判断に

導きます。  
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1   このチュートリアルを始める前に 

このチュートリアルを始める前に User’s Manual の第 1 章 および 2 章をざっと読んで Tecplot Chorus のユーザー

インターフェースを確認し操作の基本概念に慣れておくことをお勧めします。各章を読む際は、Tecplot Chorus を

開いておき、実際に操作できるようにしておくと便利です。 

• 第 1 章 - イントロダクション - Tecplot Chorus の初期画面、サポートされている入力装置、ワークス

ペース、メニューバーおよびグローバルツールバー、コンテキストメニューおよびツールバー、そして

サイドバーについて取り上げます。このチュートリアルの内容を理解しやすくするために Tecplot 

Chorus  の主要なユーザーインターフェースに慣れることをめざします。 

• 第 2 章 - プロジェクト - 初期画面、プロジェクトの基本、変数のプロパティ、ディレクトリの管理につ

いて取り上げます。続いてこれらの多くの概念を念頭に置きながら実践していきます。このチュートリ

アルが終了したら、再び 第 2 章に戻って参照してみるとよいでしょう。 

2   このガイドにおけるチュートリアル 

この 『Getting Started』 マニュアルは、チュートリアルで分かれており、身近なトピックのさまざまな側面をカ

バーするエクササイズが一つあるいはそれ以上含まれています。一般に、チュートリアルでは前半に概要が詳しく説

明されているため、順序どおりに参照してください。ただし、一度 Tecplot Chorus および Tecplot 360 EX を熟知

したら、順番に参照しなくても問題ありません。 

以下のチュートリアルが用意されています。 

• バーチャルツアー - Tecplot Chorus に用意されているデータセットを使用して、さまざまな機能を検討

します。Tecplot Chorus で最もよく使用される機能を概観するのに適しています。 

• SO2 プルーム移行観察 - 二酸化硫黄濃度を含む、産業用 CFD シミュレーションを使用して、実社会での

Tecplot Chorus の使用について紹介します。 

• 電動アクチュエータの最適化 - 航空機で使用される電子アクチュエータの設定を含む最適化の研究。設計

空間で最高の結果をもたらす領域（スィート・スポット）の発見に役立てることができる制約の可視化方

法を示します。 

これらのデータセットは Chorus Getting Started Bundle からダウンロードできます。 

掘り下げて考察し、表示をマスターしてください。 

https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
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1 バーチャルツアー 

Tecplot Chorus は、CFD プロジェクト（結果の評価にツールによる複数のシミレーションケースが必要なパラメト

リックスタディなど）を管理する堅牢なフレームワークを提供します。システム性能の全体的な評価と単独の環境で

数十から数千というシミュレーションケースの視覚的な比較が可能で、これまで以上に確信を持った素早い判断に導

きます。 

このチュートリアルでは以下の項目を含む、Tecplot Chorus で最も重要な可視化機能を紹介します。 

• プロジェクトを開く 

• 使用可能なプロジェクトの表示 

• プロジェクト内のケースと関連付けられている画像とデータの表示 

ユーザーにとって最も重要なことは、このツアーで紹介された機能を実際に操作してみることです。これより 

Tecplot Chorus で可能なことやその目的を説明しますが、理解を深めるためには実際に製品を操作することをお

勧めします。このツアーでは Tecplot Chorus に付属しているサンプルデータのみを使用しますので、データの混

乱や消去を気にすることなく作業できます。データは以下からもダウンロードすることができます。Chorus 

Getting Started Bundle   

https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
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1 - 1   プロジェクトを開く 

Tecplot Chorus に付属しているサンプルプロジェクトを開きます。サンププロジェクトは Tecplot Chorus の 

sampledata フォルダ内にあります。 

 

1.Tecplot Chorus を起動します。初期画面が表示されます。 

Tecplot Chorus を新規インストールした際に表示される初期画面では Recent Projects の下にサンプルが表示さ

れます。「Example1」がリスト表示されたらそれをクリックしてプロジェクトを開き、以下の手順はスキップし

ます。Example 1 がリスト表示されない場合は、次の手順に従ってください。 

2.File > Open Project を選択し、r Tecplot Chorus のインストールフォルダ内の sampledata フォルダを指定

し、example1.chprj ファイルを開きます。  



1 バーチャルツアー 

10 

すぐにプロジェクトが開かれます。初期画面が非表示になり、テーブルビューでプロジェクトが表示されます。 

 

ツールバーにある View メニューまたは、ボタンを使用すると別の表示を開くことができますが、これから紹介しま

すので、まだ何も開かないでください。 

 

プロジェクトには何がありますか? 入力パラメータ (または独立変数) のさまざまな組み合わせで実行

する各シミュレーションの結果、Tecplot Chorus における独自のレコードが生成され case (ケース) 

と称されます。ユーザーが各 Case (ケース)に指定するオプションの情報フィールドおよび関連する

画像やデータファイルとともに、シミュレーションの入力(独立変数)および出力(従属変数)が記録さ

れます。情報のこれらの部分は 「データについてのデータ」 (シミュレーションによって生成された

ソリューションファイルが実データ) のため、それらは総称して メタデータ と呼ばれることがありま

す。  

 まずは既存のプロジェクトを確認し、そのレイアウトを見てみましょう。 
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1 - 2   テーブルビューについて 

プロジェクトを開くと、すぐにテーブルビューが表示されます。テーブルビューは、ツールバーにある をクリ

ックするか、 View  New Table View を選択していつでも開くことができます。テーブルは以下のように表示され

ます。 

 

視覚的観点からするとテーブルビューはあまり興味深い表示形式ではありませんが、プロジェクトにおける実際の数

値を確認するには非常に便利です。プロジェクトを開きテーブルは既に開かれていますので、ここから開始します。 

テーブルビューの各行は、入力値の一意的な組み合わせと関連付けられた一つのケースを意味します。確認すると次

のことがわかります。 

• 各ケースは行として示され、関連する値は列として示されます。各ケースは同じ一連の変数を持ちます。 

• 各ケースには CaseID が数値で割り当てられます。最初のケース ID は 1 で、インポートされた新規の各

ケースには、さらに上位の次の番号が割り当てられます。これは、ほかのユーザーと特定のケースについ

て意見を交わす場合に省略表現として便利です。 

• 最も大きい Case ID が 191 であるため、このプロジェクトには 191 のケースが存在すると簡単に分かり

ます(一番下までスクロールダウンして確認してください)。 
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• CaseI D の他に「 Mach No.」、「Alpha」、「Beta」、「#Iterations」、「Lift」 、「Drag Coef」、「Pitch 

Mom.Coef.」と名前が付けられた 7 つの列があります。右にスクロールするとこれらのすべてを確認す

ることができます。それぞれの列は変数を表しています。 

航空宇宙のエンジニアであれば、最初の 3 列は共通の独立変数(シミュレーションへの入力)で、ほかは従

属変数(シミュレーションからの出力)であるとお分かりになるでしょう。 

• 各セルの上部には薄くチェックマークが表示されています。これらのチェックマークは各セルの値がプロ

ジェクトの変数範囲に入る箇所であることを示し、左端では変数の最小値、右端では最大値を表します。

テーブルを下にスクロールすると Case ID のセル内のチェックマークは予想どおり左から右へ移動しま

す。チェックマークは他の列にどのように移動するか（必ずしも順序よくではありません）確認してみて

ください。 

• シェーディングされている列や、赤字で示された値に気づ

くでしょう。このような表示でフィルタリングの結果が分

かりやすく視覚的に示されます。シェーディングはフィル

タリングされている高い値と、低い値の割合を意味しま

す。赤色の値は列のフィルタリングを通過した値です。 

プロジェクトには入力や出力ではなく、本質的に情報を含む変数を含

めることもできます。これらの変数は日付、シミュレーションを実行したエンジニアの識別、実行したクラスタ

ー、および似たような管理情報を記録することができます。このサンプルプロジェクトにはこうした変数はあり

ません。 

ケースおよび変数をプロジェクトに追加したり、Tecplot Chorus 内で変数を計算したりすることも可能です(詳細に

ついては、『User’s Manual 』 の Chapter 2 を参照してください)。 

 列のヘッダーをクリックすると、変数の昇順でテーブルをソートすることができます。同じヘッダーを再度（2 回

目）クリックすると、降順にソートされます。これによりプロジェクト内で任意の変数の範囲を簡単に決定すること

ができます。試してみてください。 

Table View と同様に、選択したケースのみを表示することができます。View メニューから Selected 

Cases を選択すると、この表示にすることができます。他のビューで選択したケースの値を確認する際に

便利です。 

1 - 3   マトリクスビューについて 

マトリクスビューを使用すると、ケースの一部またはすべてに関連付けられたサムネイル画像を使用して、プロジェ

クト内のケースを視覚的に取捨選択することができます。行、列、およびオプションでページを割り当てて、プロジ

ェクト内で任意の変数を示すことができます。  

新しいマトリクスビューを開くには View  New Matrix View を選択するか、 ツールバーで  をクリックしま

す。マトリクスビューがテーブルビューの初期画面の隣または上に部分的に表示されます(使用可能領域によって異

なります)。 
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ウィンドウを管理する  ツールバーボタンをクリックしてビューを開いたりプロットしたりするたび

に、既に開いている場合でも、その形式で新規にビューやプロットが開かれます。新規ウィンドウは、

少なくともほかのウィンドウも一部見えるように配置されますが、常にそのスペースがあるとは限りま

せん。 

ウィンドウを開いたときにそのプロットが既存のウィンドウを覆ったとしても、既存のウィンドウは隠

れているだけでそこにあります。プロットを新たに開いたとき、これまで丹念に設定したプロットを失

ってしまったかと懸念する必要はありません。既存のプロットは新規プロットの下に存在しています。

ツールバーにある  ボタンをクリックして、開いているすべてのウィンドウをグリッド表示すると、

目的のウィンドウを見つけやすくなります。 

初期画面 ( ウィンドウサイズに応じて各ユーザーで異なる場合があります ) で表示されるサムネイル画像はごくわ

ずかです。 

 

画面が小さい場合は、ワークスペース全体を使用するようにウィンドウを最大化することができます。その場合、ウ

ィンドウ右下隅のズームスライダーを使用してサムネイルを最小化すると、マトリクスビューでさらに多くのセルを

確認することができます。以下のように表示できるはずです。 
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このとき次の点が確認できます。 

• マトリクス内のいくつかのセルは空白です。サンプルプロジェクトでは、これらのいくつかは不明なケー

スで、実行されていないシミュレーションです。実際のプロジェクトでは、さらにまばらに表示されるこ

とがよくあります。 

マトリクスのセルが空白であるもう一つの理由は、そのセルに属するケースに関連付けられた画像が一つ

もないことです。しかし、このサンプルプロジェクトでは該当しません。 

• 変数 Mach No.および Alpha がマトリクスの列と行にそれぞれ割り当てられました。これらの変数は変更

することができます。 

• 各変数の離散値は独自の行と列を得ます。 

ケースをいくつかクリックしてみてください。開いたテーブルビューがまだ表示されている場合、マトリクスビュー

でセルをクリックすると対応する行がハイライトされます。Tecplot Chorus では、一つのビューでケースを選択す

るとすべてのビューでそれが選択されます。また、View > Selected Cases から在選択されているケースのみが表

示される特別なドッカブル・テーブルビューを開くこともできます。 

マトリクスビューで複数のケースを選択することができます。マトリックスセルの代わりに行や列のヘッダーをクリ

ックしてみてください。セルやヘッダーをクリックしているときに Control か Shift、またはその両方を押してみて

ください。以下を考えてみてください。 
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1.最も速く列 0.2、1.2、1.8 のみを選択する方法1 

2.最も速く最後の 3 つの行を選択する方法2 

1 - 3. 1   マトリクスビューのプロパティ 

サイドバーの Properties （プロパティ） パネルでマトリクスビューのオプションを

選択することができます。通常、Properties パネルはワークスペースの左側で確認す

ることができます。Properties パネルが開かれていない場合は、 View > Properties 

を選択して開いてください。 

形式が同じでも、開いたビューやプロットはそれぞれ固有のプロパティを持ちます。 

例えば、複数のマトリクスビューを開いている場合、それぞれのマトリクスビューは

独自のプロパティを持ち、他のマトリクスビューのプロパティからは完全に独立して

います。 

テーブルビューのプロパティについてテーブルビューのプロパティに

ついては、設定が一つのみであり、またこのレッスンで触れていない

フィルタリングに関係しているため説明を省略します。 

マトリクスビューを見てみると以下の内容が確認できます。 

• マトリクスの行と列で使用する変数を変更することができます。Alpha に

対して Mach No. を、 Beta に対して Alpha を試してみてください。 

• 3 番目の変数をページングに選択することができます。現在、行と列に Alpha と Beta を使用しているた

め、ページング変数として Mach No.を選択してみてください。それから、Properties パネルのスライダ

ーを使用してページを行き来してみてください。 

                                 
1 . 解答: 列 0.2のヘッダーをクリックし、Controlキーを押しながら列 1.2および 1.8のヘッダーをクリックします。 
2 . 解答: 最後の行のヘッダーをクリックし、Shiftキーを押しながら最後から 2番目のヘッダーをクリックします。 
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• 行、列、そしてページとしても、4 つの従属変数を使用することができます。通常これは特に有用では

ありません。ほとんどの場合、プロジェクトにはさまざまな従属変数の離散値があります。そのため、

その変数の行や列が数多く表示されることになり、画像が大きく広がって表示され操作しづらくなって

しまいます。しかし# Iterations で試してみると、Mach No.とともに以下のように表示されます。 

いくつかのセルには  印が付いていることに気が付きましたか? この印は、行、列、およびページとし

て表示されている変数の値が同じケースが複数あり、これらのケースのうち二つ以上が画像と関連付け

られていることを示しています。印が付いたサムネイル上にマウスを重ねると、ツールチップによって

そのセル内にいくつ画像が重なっているか確認することができます。マトリクス内でハイライトされた

以下のセルでは、1 つのサムネイル、そして 6 つの画像の合計 7 つ画像の存在が示されています。 

 

サンプルプロジェクトではすべてのケースに画像があるため、7 つの画像が 7 つのケースに対応します。

マトリクス内のセルを選択しテーブルビューに切り替える（または Selected Cases ビューを開く）と、

これら 7 つのすべてのケースが実際に選択されたことがわかります。 

• Properties パネルの Show メニュー内では、オプションとして"Contour Image"のみが表示されます。 

サンプルプロジェクトでは 1 種類しか画像がありませんが、各ケースは関連付けられた複数の画像を持つ

ことができます。このサンプルプロジェクトに、ケースと関連付けられた複数の画像があれば、このメニ

ューを使用してマトリクス内のサムネイルとして表示する画像を選択することができます。 

考察: 行、列、およびマトリックスの追加ページのために選択した変数に基づいてサムネイルが選択されます。複数

のケースがこれらの変数に一致し、かつ画像を持つ場合は、代表のケースが実際のサムネイルの表示に選択されま

す。スライダーのラベルをオンにして、使用していない変数の値を確認することができます。それから filtering を
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使用してこれらの値を間接的に選択することができます。ここではフィルタリングについて説明はしませんが、

Filters のサイドバーで試してみることをお勧めします。 

1 - 4   関連付けられた画像の表示 

マトリクスビューのすべてのサムネイルは、プロジェクトで一つ以上のケース(それに関連付けられた一つ以上の画

像を持つケース)を表しています。（画像を伴わないケースはランが実行されていないケースと同様に空白で示されま

す）これらの画像をマトリクスビューからフルサイズで表示する手順は次のとおりです。 

1.Properties サイドバーの Show メニューを使用して表示する画像の形式を選択します。サンプルプロジ

ェクトでは、Contour 画像のみが使用可能になります。 

プロジェクトに複数の画像形式がある場合、マトリクスビューに表示された画像形式以外で表示するこ

とができます。マトリクスを切り替えて目的の画像形式を表示するとこれらの画像を持つケースの検索

が容易になります。 

2.関連付けられた画像を表示するケースを一つ以上選択してください。 

関連付けられた画像を持たないケース (マトリクスで空白のセル) をいくつか選択したとしても問題あり

ません。その場合、画像の表示を指定しても表示されません。 

3.選択した画像をポイントしながらマウスを右クリックし、View Images を選択します。画像が別のウィ

ンドウに表示されます。 

 

ほかのビューのように、画像ウィンドウにも独自のプロパティがあります。以下の操作をしてみてください。 

• ラベルをオンにして、各ケース (ここに表示された画像ビューアーウィンドウのラベルは既にオンになっ

ています) に関連付けられた変数の一部またはすべての値を確認します。 

• 別の形式の画像を選択します。このプロジェクトには用意されていませんが、存在する場合はサイドバ

ーの Properties の Tag メニューから選択することができます。 

• 選択したケースのすべての変数値を表示します。画像をクリックするとサイドバーの右に表示されま

す。 
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• 選択した画像との相違を示す画像を表示します。画像をクリックしてマスター(ほかが比較される画像)

として選択します 。それから Diff From Current をクリックします。画像同士の違いとともに新規ウィ

ンドウが開かれます。 

Congratulations! ビューでの動作はすべて同じです。これで、すべてのビューで画像および、それらの違いを表

示する方法を習得しました。プロジェクトを開いたとき(または新規プロジェクトを開いたとき) に開かれたテーブ

ルビューに戻り、行をいくつか選択して右クリックします。そこからは先の操作は同じです。以降、Tecplot 

Chorus に用意されている 3 種類のプロットの紹介に向けてこの点を心に留めておいてください。 

1 - 5   関連付けられたデータの表示 

これまで、マトリクスビューからケースに関連付けられた画像ファイルを表示する方法を紹介してきました。ケース

は関連付けられたデータファイルを複数持つこともあります。実際、CFD のワークフローに慣れているユーザーで

あれば、ソルバーやスクリプトで呼び出される典型的な後処理段階としてソリューションデータファイルから画像フ

ァイルが作成されることをご存じでしょう。Tecplot Chorus でもデータファイルから画像を作成できますが、それ

についてはこのレッスンでは触れません。まずはデータファイルを 表示する ことのみに重点を置いて説明します。 

Tecplot Chorus は、Tecplot 360 を使用してデータを表示します。Tecplot360 を使用すると、一般的な CFD ソル

バーから出力される多様なデータファイルを読み込むことができ、そこから出力に対応したプロットやアニメーショ

ンを作成し、生の結果についてさらに解析を実行することができます。  

Tecplot 360 を起動し、Tecplot Chours 内のケースに関連付けられているファイルを開くことを我々は"deep dive" 

と呼んでいます。これまでサムネイルおよび、さらに大きな画像をいくつか確認してきましたがこれはプロジェクト

における膨大なデータのうわべでしかありません。Tecplot 360 内のケースに関連付けられた実際のデータファイル

を開けばプロットのズームや回転、等高線や軸ラベルの追加、スライスして分割することなどが可能です。これによ

りデータから重要なアイデアを得ることができ、さらに深く掘り下げることができます。 
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手順は画像の表示で説明した内容とほとんど同じです。唯一の違いは右クリックした後、View Image の代わりに 

View Data を選択することです。Tecplot 360 が起動し、選択したデータファイルが別のフレームにそれぞれ開か

れ、制御できるようになります。

 

Tecplot 360  を操作しているとき Chorus というタイトルで追加されたサイドバーを確認することができます ( こ

のショットでは右側にドッキング表示されています) 。サイドバーには Tecplot 360 で動作する Tecplot Chorus の

機能が含まれています。  

例えば、Chorus で画像を比較するのと同じようにデータを比較することができます。ほかのフレームと比較したい

フレームをクリックし、Set Current Frame as Master ボタンをクリックします。それから Show diff data チェ

ックボックスをオンにします。 

Chorus のサイドバーにあるほかの機能も自由に操作してみてください。そして、以下の点を理解してください。 

• View Page セクションで Tecplot Chorus で開かれたページを管理することができます。Tecplot 

Chorus でデータを開くたびにデータは新規ページに配置されます。Tecplot 360 の全体の新規インスタ

ンスは開かれません。 

• Label Frames セクションでプロットのラベルに表示される変数を選択することができます。 

• Save as Style Template ボタンでプロットのスタイル（外観）を別のファイルに保存することができま

す。スタイルは、ほかのデータファイルに自動的に適用して新規画像を作成することができ、Tecplot 

Chorus でアクセスすることが可能です。 
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• Synchronize Styles ボタンで現在選択されているフレームからスタイル（外観）をほかのすべてのフレ

ームにコピーすることができます。 

今すぐに理解できなくても問題ありません。このレッスンでは、Tecplot Chorus の基本的な特徴に慣れること、お

よび各機能の理解と習得を支援することを目的としています。Tecplot 360 についての説明が少し長くなりました

が、これは独自で豊富な機能を持つ Tecplot Chorus とは全く別のアプリケーションです。セッションのこのパート

では、Tecplot Chorus と Tecplot 360 の 2 つのアプリケーションが森と木のように密接に統合されているというこ

とを示します。 

少し操作してみたら、Tecplot360 を終了してください。次に Tecplot Chorus のプロットについて説明します。 

1 - 6   プロット 

テーブルとマトリクスがあれば十分です。魅力的なグラフィックをいくつか見てみましょう。Tecplot Chorus では 

3 つのプロットタイプが用意されており、ツールバーのボタンまたは、View メニューのコマンドを使用してアクセ

スすることができます。 

3D Scatter Plot (3 次元散布図) 

2D Scatter Plot (2 次元散布図) 

Line Plot (ラインプロット) 

これよりそれぞれのプロットタイプを簡単に確認しますが、まずはプロットの操作に使用する以下のツールについて

説明します。 

Select (選択) - プロットや、ほかのデータビュー内の個々のケースやケースのグループを選択する

ことができます。 

Translate (移動) - ウィンドウ内で 3 次元プロットを動かすことができます。2 次元およびライン

プロットの場合、データが移動する間、軸は所定の位置にとどまります(軸の範囲が変化します)。 

Rotate (回転) - 3 次元プロットを回転することができます。2 次元またはラインプロットには使用

できません。  

Zoom (ズーム) - プロットを拡大したり縮小したりすることができます。  

ツールがアクティブなときに、ズームするウィンドウ内にマウスポインターを置いて、マウスのスクロ

ールホイールを動かすとプロットをズームすることもできます。 

これらのコントロールは各プロットで若干異なった動作をします。違いを確認してみてください (または 『Tecplot 

Chorus User's Manual』 の Chapter1 を参照してください)。 

View > Reset を選択してプロットをデフォルト表示に戻します。 
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1 - 6. 1   3D Scatter Plot (3 次元散布図) 

3 次元散布図は、Tecplot Chorus でおそらく最も見栄えの良いプロットで、ツールバーの  をクリックするか 

View > New 3D Scatter Plot を選択してアクセスすることができます。 

 

散布図内のそれぞれの球はプロジェクト内の単独のケースを示しています。これは、3 次元ですので回転させて楽し

んでみてください。ツールバーにある Rotate アイコンをクリックし、プロットウィンドウにドラッグしてくだ

さい。別の角度からデータを見ると新たな視点が得られます。 

Properties サイドバーには、散布図プロットの外観を変更できる多くのオプションが用意されています。(ここで 

は Surrogate Model( 代用モデル ) 項目の下のオプションについては取り上げません)。特に以下の点に注意してく

ださい。 

• X、Y、Z の軸に表示する変数を選択することができます。一般には、二つの従属変数を X と Y 軸に、一

つの独立変数を Z 軸に選択します。 しかし、ときには別の設定を使用したいことがあるかもしれませ

ん。三番目の独立変数を使用するといくつかのパラメータ値周辺のケースのクラスタリングを表示するこ

とができます。日付やスタッフメンバーなどの情報変数を Z に 使用すると、例えば「同じ日付」や「同

じスタッフメンバー」などによってケースがレイヤー （各レイヤー上のケースがすべて実行された場

所）に整理されます。従属変数を複数使用すると相関関係を表示することができます。 

• 各軸の範囲は変更することができます。デフォルトでは選択した軸の変数の最小値から最大値までのすべ

ての値が表示されます。 

• 各ドットのカラーを変数で決定することができます。この変数はプロットの軸上の変数の一つ、または 4

番目の変数です。変数の最低値は青、最高値は赤になり、中間の値はレインボースペクトルになります。  
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サンプルプロジェクトでは、ケース ID による色付けは最初にインポートされたケース(青)および、後か

らインポートされたケース(赤)を表しています。または、#Iterations によって色付けすることができ、

解が収束するまでに要したケースの得た反復回数を示す色を割り当てることができます。 

 

色の値のマッピングを示す凡例をオンにすることができます。凡例をプロットの周辺にドラッグして任意

の場所に配置します。凡例をプロットの上部か下部に動かしたとき、どうなるか確認してください。凡例

内の手順の概数を選択することもできます。 

• 変数の値で各ケースの色を決定できるのと同様に、サイズ も変数の値で決定することができます(球体か

ら正方形に変更することもできます)。Beta および倍率 0.5 で試してみてください。その後、立方体を

試してみてください。 

• 右クリックしてプロットを画像として保存することもできます。この機能も実際に試してみてください。

画像は Portable Network Graphics (PNG) 形式で保存されます。 

任意のプロットまたはビューのインスタンスは各プロパティと共に複数開くことができることを思い出してくださ

い。二つの 3 次元散布図を開き、それぞれを異なった方法で回転させてみてください。また、Properties パネルを

使用して各軸に独自の設定をして表示してみてください。 

散布図でケースを選択できることに注意してください。つまり、プロットからもプロジェクト内のケースに接続可能

で、プロットは単なるプロットではなくケースに接続する別の経路でもあります。(Tecplot Chorus のプロットはす

べてこのように動作します)。ツールバーで Select ツールを選択し、球体または立体をいくつかクリックしてく

ださい。Control キーを押しながらクリックして複数のケースを選択するか、選択するケースの周囲を矩形にドラッ

グしてください。 
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同期選択 ほかのビューまたはプロットが開かれている場合、3 次元散布図で選択したケースがほかの

ビューでも選択されることが確認できます。一つのプロットまたはビューで選択されたケースは、す

べてのプロットまたはビューでも選択されます。これは Tecplot Chorus における普遍的概念です。

この機能について繰り返し言及しませんが、心に留めておいてください。 

ケースか軸を選択したら右クリックします。マトリクスビューに関する説明で取り上げた画像やデータの表示と同じ

オプションがここにもあります。実際に操作して同じように機能することを確認してください。 

1 - 6. 2   2D Scatter Plot (2 次元散布図) 

2D Scatter Plot (2 次元散布図) は既に説明した 3D Scatter Plot (3 次元散布図) と似ています。X とＹ軸に変数を

指定するだけで実行でき、変数で散布のシンボルの色やサイズを指定することもできます。 

このサンプルプロジェクトでは、X と Y 軸にそれぞれ Alpha と Lift Coef.を持ち、#lterations 変数を使用して色付

けされた 2 次元散布図を作成します。凡例を追加し、データの邪魔にならない場所に配置します。この結果のプロ

ットで、Alpha は Lift に対してほぼ線形の好ましい影響を与え、ほとんどのケースは 200-250 回反復して収束する

ことが分かります。 

 

X 軸の変数を Beta に切り替えると、Lift 対する Beta の関係がさらに複雑であることが明らかに分かります。 
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1 つの独立変数を別の従属変数にプロットすると、相関関係を明らかにすることができます。以下は、Lift 対 Drag 

(Mach No.で色付けされた) プロットで、Mach No.,Lift と Drag は二次で正の関係があるように見えます。 

 

3 次元散布図と同様に、2 次元散布図でもケースを選択し、データを表示することができます。Control キーを押し

たり離したりしながらクリックしてみてください。また、ケースの周囲を矩形にドラッグしてみてください。次に右

クリックして、選択したケースに関連する画像やデータを表示してください。 
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フィルターを操作していて、色付けを “Color by Filter Violations” に指定している場合、プロジェクトに陰影が表

示されることがあります。これは軸変数に機能するフィルターの効果を視覚化します。各ケースは通過したフィルタ

ーの数の応じて色付けされます（詳細については凡例を参照）。 

 

1 - 6. 3   Line (ライン) および Symbol (シンボル) プロット 

Tecplot Chorus の ラインプロット（  ボタンまたは View > New Line Plot）は、各ケースのシンボル、ケー

スを統合するラインまたは、シンボルとラインの両方を表示でき、実際には 3 つのプロットが一体になっていま

す。 

一見すると、ラインプロットは 3 次元散布図よりも地味ですが、結果のやり取りに幅広く使用できる手段です。これ

からプロットを再現するので続いて操作してみてください。少し制限はありますが、コントロールはこれまでほかの

プロットで見てきた内容と同じです。3D 散布図と同様に、ここでも Properties パネルの Surrogate Model (代用

モデル) については取り上げません。 

軸に加えて、カラーおよび/またはシンボルシェイプを選択し、最大 2 つまでの変数を表示することができます。カ

ラーまたはシンボルに変数を使用すると、その変数の離散値が各自のカラーやシンボルの形状を使用して、(ライン

がアクティブであれば) 独自のラインとして描画されます。 
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このプロットに適用された設定が分かりますか?1 

このプロットでも同様にケースを選択し、画像やそれらのデータを表示することができます。これはもう目新しい機

能ではないかもしれません。ラインプロットのシンボルをオンにすると、滑らかで起伏の少ないラインでない限り、

実際にケースがどこにあるのかを見つけることができて便利です。 

1 - 7   Sessions（セッション） 

セッションという概念とともに、このレッスンを終了します。Tecplot Chorus のセッションには、作業していた

プロジェクト、開いていたウィンドウ、デスクトップ上の位置やサイズ、および Properties (プロパティ) サイド

バーにあるすべての設定が記憶されます。この機能は毎回、同じセッションを使用して常に同じ状態から作業を

開始する場合でも、操作を終了したときに保存された最後のセッションを使用してちょうど作業が中止された状

態から開始する場合でも、どちらの場合でもその状態を保存するのに便利な方法です。プロジェクトと同様に、

最近使用したセッションが初期画面に表示され、すぐにアクセスすることができます。 

File メニューに Tecplot Chorus セッションをロードして保存するコマンドがあります。また、Tecplot Chorus を

終了するときに、即座にその場のセッションを保存するオプションも用意されています。練習: セッションファイル

を作成し、現在の作業を記録してください。それから Tecplot Chorus を終了して再び起動し、保存したセッション

を開いてください。 

                                 
1 . X-Axis: Mach No. Y-Axis: Lift Coef. Show Lines. Sort By: Mach No. Color: By Variable/Alpha. Symbol: Shape/ 

Circle. Symbol Size: 1 
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1 - 8   最後に 

これまで Tecplot Chorus の主要な高機能を紹介してきました。まだお読みでない場合はここで 『User's Manual』

を確認することをお勧めします。Tecplot Chorus の概念とユーザーインターフェースの要素について説明しており、

既に学んだ内容とこのガイドの後半での説明を結びつけるのに役立ちます。  

次のような興味深いトピックが含まれています。 

• How to create projects and import data. (プロジェクトを作成し、データをインポートする方法) 使用し

た変数および、各ケースに対するそれらの値が Tecplot Chorus にどのように認識されるかを説明しています。新

規データを追加して、新規のケースや変数、またはその両方に使用することもできます。 

• How to set up filters so you can easily find the cases you’re interested in.( 興味のあるケースの検索を

容易にするフィルターの設定方法) フィルターはマトリクスビューと Surrogate Models （代用モデル）とも関

連があります。 

• How to create new image files using existing data files (既存のデータファイルを使用して新規画像ファ

イルを作成する方法)。このツアーではこの機能に触れました（Tecplot360 との統合の一部）が、今後のチュー

トリアルで順を追って説明します。 

• How to use a Surrogate Model. (代用モデルの使用方法) まだ実行していないシミュレーションや実験の結果

を近似することができ、設計空間で有益な部位を特定するのに役立ちます。このトピックについては、今後のチュ

ートリアルでも取り上げます。 
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2 SO2 プルーム移行観察 

二酸化硫黄 (SO2) ガスの排出は、工業工程で人為的に行われるだけでなく、火山噴火のような自然事象の副産物で

あることもあります。酸性雨および深刻な大気汚染の元となる SO2 の排出は人間の健康および、環境に深刻な悪影

響を与えます。そのため、アメリカ合衆国環境保護庁（United States Environmental Protection Agency/EPA）

は、工業生産における SO2 の排出に関して一連の厳しい産業規制を打ち出しました。 

計算流体力学 (Computational Fluid Dynamics/CFD) は、さまざまな状況における製造設備の設定を検証する標準

的方法となっています。エンジニアは、しばしば CFD を使用して、製造設備の初期設計が EPA 基準に合致するか

を判断します。  

このチュートリアルでは、エンジニアが提案した設備設計での排出が EPA 基準内の SO2 濃度に収まるかどうかを

Tecplot Chorus を使用して効果的に判断する方法について示します。EPA 基準を満たすには、排気口から一定の距

離における SO2 濃度が規制値よりも低くなければなりません。 

この調査のために 16 のシミュレーションが実行されました。SO2 の影響の初期評価を得るために、異なる空気の流

れと、初期 SO2 排出の組み合わせが検討されました。各調査では、複数の場所で濃度を確認しました。 

このエクササイズでは Plume（プルーム）データセットが必要です。Chorus Getting Started Bundle をダウンロ

ードすることができます。 

このデータは ZIP ファイルで圧縮されており、使用するには、各ファイルを解凍する必要があります。  

https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
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2 - 1   CSV ファイルの分析 

Tecplot Chorus のすべてのプロジェクトは、実行した各ケースについてのメタデータで構成されており、以下のよ

うな情報の幅広いカテゴリを含むことができます。 

• それぞれのシミュレーションで使用あれた入力パラメーター（独立変数） 

• シミュレーションにおいて重要な出力値（独立変数）: この調査では、さまざまな場所での SO2 濃度 

• それぞれのシミュレーションに関する情報（使用されたソルバー、要した CPU 時間など）を記録する情

報フィールド 

• ソルバーおよび/またはポストプロセッサで作成された補助データおよび/またはイメージファイルの名前

またはパス （それぞれのケースを参照する際に開かれる） 

SO2 データセットには、この調査のメタデータが含まれた CSV ファイル、plume_input.csv が格納されていま

す。 CSV ファイルは任意のエディタ（メモ帳など）やスプレッドシートプログラム読み込むことが可能で、データ

の表形式の特性を簡単に見ることができます。以下は Microsoft Excel の画面です。列が拡大されており、各成分の

すべての値を見ることができます。

 

任意の CSV ファイルの最初の行は、各フィールド（データ項目）の名前が表示されたヘッダー行で、それぞれの名

前はカンマで区切られます。.csv  の入力では 12 のフィールドがあるのが分かります。 

標準の CSV ファイルでは、ヘッダー行にできるのは 1 行のみですが、Tecplot Chorus では、任意で各フィールド

のタイプを示す 2 番目のヘッダー行を使用することが可能です。入力パラメータ (“Independent”), 出力値 

(“Dependent”), 厳密な情報フィールド (“Other”), または、ケースに関連付けされたイメージファイル (“AuxFile”)

種類は最初の行内のフィールドと同じ順序で表示されます。 

CSV ファイルに 2 番目のヘッダー行が含まれない場合、テキストエディターを使用して、簡単に 2 番

目のヘッダーを追加したり、ファイルのインポート時に Tecplot Chorus 内の各フィールドの種類を指

定したりすることができます。独自のヘッダー行を追加する場合は、正確なスペルで 

“Independent,” “Dependent”, “Other” および “AuxFile” を使用する必要があります。これら 4 つの

特定用語以外のテキストが含まれると、Tecplot Chorus で 2 番目のヘッダー行は認識されません。 
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それぞれのフィールド名と 2 番目の行の種類を一致させると、以下がわかります。 

• 3 つの独立変数 (入力またはパラメーターとも呼ばれます): SO2 の South East (mph), North East 

(mph) および Mass Fraction これらは、卓越風の速度と排気口における SO2 の濃度を表します。 

• 8 つの独立変数 (outputs または results とも呼ばれる): downwind 75, downwind 50, downwind 

25, Elev 5, Elev 15, Elev 30, Elev 100, cross wind 0 これらは、それぞれのケースのさまざまな場所

の SO2 濃度のシミュレーションを示しています。 

• 情報変数なし（種類 “Other”) 

• 単一の補助ファイルフィールド、 FileName 各行のテキストの最後の部分を見ると、すべての名前が .plt 

で終わることがわかります。これは Tecplot 形式のバイナリデータファイルであることを意味します。 

ヘッダー行の後で、CSV ファイルにはケーススタディの各ケースの行が含まれます。各ケースの値は、最初のヘ

ッダー行内の順序になります。CSV ファイルには合計 18 行があり、2 つのヘッダー行が引かれています。これは、

事前に伝えたとおり、16 のケースが存在することを示しています。 

2 - 2   Tecplot Chorus Project の作成 

CSV ファイルは調査の入力と結果の “平坦” 表現です。これらのケースは恐らく、シミュレーションされた順番で記

述されており、ユーザーが作業したい順番ではない可能性があります。CSV を使用して Tecplot Chorus でプロジ

ェクトを作成する場合、パワフルなリレーショナルデータベースにインポートされ、さらに自由かつ柔軟にデータの

表示と分析が可能になります。 

Step 1  Tecplot Chorus の起動 

まず、 Tecplot Chorus アプリケーションを起動します。例えばインストール時に作成された Windows

デスクトップのショートカットをダブルクリックします。（Linux ユーザーは、ターミナルウィンドウで 

chorus と入力する必要があります）。 

Step 2  CSV プロジェクトを開く 

File メニューから Open CSV Project を選択します。これは、新規 Tecplot Chorus 

プロジェクトを作成する最も簡単な方法で、CSV 形式が完全にフォーマットされ、

作業できるようになります。  

カンマ以外で区切る必要がある場合や、CSV ファイルに 2 番目のヘッダー行が存在

しないため、変数の種類を指定する必要がある場合、Tecplot Chorus はこの種類の

ファイルも扱うことができます。 

Step 3  入力ファイルの選択 

Select Delimited Text Metadata File ダイアログを使用して、Plume フォルダ内の plume_input.csv を選択し

たら、Open ボタンをクリックします。 
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CSV ファイルから新しいプロジェクトファイルが作成されます。プロジェクトのデータベースファイル 

plume_input.chprj は、CSV ファイルと同じフォルダに作成され、同じベースネームが付けられます。2After プロ

ジェクトファイルを作成すると、Tecplot Chorus は自動的に以下のようなテーブルビューを開きます。 

 

16 のケースすべてを見ることができます。少し水平にスクロールすると、それぞれのケースのすべてのフィールド

を見ることができます。FileName フィールドが表示されないことに注意してください。代わりに、このフィールド

は、各ケースがそれぞれのデータファイルにリンクするために使用されます。これは、個々のケースのデータファイ

ルを開くときに使用されます。 

2 - 3   物理的可視化およびプロット画像の作成 

このエクササイズでは、Tecplot 360 を使用して、個々のケースのデータを表示し、スタイルのテンプレートを作成

して、この調査のすべてのケースの画像を自動的に作成します。 

Step 1  Flow Solution を検討する 

まず、Table View で一番目のケース（Case ID 1）を右クリックし、コンテキストメニューから View Data を選択

します。 



2 SO2 プルーム移行観察 

32 

 

View Data ダイアログが表示されます。 

 

ケースのデータを表示するため、このダイアログでは何も変更せず OK をクリックします。Tecplot 360 が開かれ

て、データファイルが表示されます。 
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Step 2  より良い View を得るために 

これから Tecplot 360 を使用して、表示を拡大したり、回転したりして、上部に排気口がある 2 つの建造物を詳し

く見ることにします。 

まず、ズームインしましょう。 Tecplot 360 ツールバーの ズームツールの使用により拡大することができます。

より簡単な方法として、キーボードで  Control キーを押しながら、マウスの中央のボタンまたはホイールを押し、

プロット中央付近でマウスを上下にドラッグすると、拡大/縮小することができます。拡大して、以下のように 2 つ

の建造物が見えるようにします （これと全く同じように表示する必要はありません）。 

 

建造物の表を上にして、プロットを回転させましょう。2 つのボックスの間にマウスポインターを置いて（クリック

はしないでください）、キーボードの O キーを押し、回転の中心を設定します。プロットを回転したときに、この点

を中心に回転するようになります。こうすることで、画像を回転させることなく、画面に保持しやすくなります。 

Tecplot 360 では、ツールバーに回転用のツールがいくつか用意されています。 ローラーボール回転ツールは、

一般に使用されるツールのため、ショートカットが用意されています。 キーボードの Control キーを押したまま、

マウスの右ボタンを押しながら移動します。（ご使用のコンピュータに 3D マウスが接続している場合は、それを使

用することもできます） 
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回転させるにつれて、建造物が中央に配置されず（または一部が画面からはみ出して）プロットを移動する必要があ

ることに気付くかもしれません。ツールバーにある     Translate (a.k.a. Move) ツールを使用して移動するこ

とができます。また、これはよく使用するツールで、ショートカットが用意されています。マウスの右ボタンをクリ

ックしたまま、プロットを任意の位置にドラッグします。  

プロットをズーム、回転、および移動することで、Y 軸を垂直方向に真っすぐにすることが可能で、その他のプロッ

トはおよそ、以下の図のような方向に向けられます。 

 

 constrained  rotation tools (回転制回転四角形の取得に問題がある場合は、ツールバーの

約ツール) を使用して、1 度に 1 つの軸の周りを回転させてください。  

しかし、一般に Tecplot 360 での回転、ズーム、移動のマウスショートカットの使用を覚えると、ツー

ルバーに移動する手間を減らすことができ、より円滑に操作することができます。簡単にまとめます。 

- 移動: マウスの右ボタンを押してドラッグ 

- 回転 (ローラーボール): Control キーを押しながら、マウスの右ボタンを押してドラッグ 

- ズーム: Control キーを押しながら、マウスの中央ボタン（ホイール）を押してドラッグ 
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プロットを回転させると、小さい方の建造物の上に点が表示されます。これが排気口です。上記のスクリーンショッ

トで表示されています。 

Step 3  SO2 濃度を示すポートを介してスライスを追加する 

排気口の上の空気を通って右にスライスを追加し、平面に沿って SO2 濃度を表示します。 

最初に、Tecplot 360 Plot サイドバーの Derived Objects セクションで Slices チェックボックスを有効にします

（以下参照）。 

プロットにスライスが表示され、最初に圧力で等高線に色が付けられます。  
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次に、 Slices チェックボックスの隣にある Slice ボタンをクリックして、Slice ツールを有効にします。そして、排

気口を通るようにスライスをドラッグします。 

 

スライス位置は厳密である必要はありませんが、正確さを求めるならば、排気口は X = -10 です。そ

のため、希望する場合は（Plot サイドバーの Slices チェックボックスの隣にある Details ボタンを使

用して） Dlice Details ダイアログを開き、 slice position フィールドに-10 と入力してください。 

Plot メニューから om the Plot メニューから Contour/Multi-Coloring を選択して、Contour & Multi-Coloring 

Details ダイアログを開きます。 
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このダイアログのメニュー上部で変数を so2 に設定します。（ダイアログを開いたままにします）プロットが以下の

ように表示されます。 

 

以前と同じツールを使用してプロットをズームして配置変更し、排気口に焦点を合わせて、凡例の後ろの乱雑さを回

避しましょう。プロットは以下の範囲にあるはずです。 
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最後に、ツールバーにある  Add Contour Level ツールを使用して、近くのポートに等高線レベルを追加し

ます。これにより、識別できる等高線レベルが増えます。排気口の左側をいくつかクリックするだけで、ツールがど

のようにして等高線レベルを追加するかを確認することができます。(Contour & Multi-Coloring Details ダイアロ

グでも新しい等高線レベルが表示されます)。  
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プロットが以下のように表示されます。 

 

Contour & Multi-Coloring Details ダイアログを閉じることができます。 

2 - 4   スタイルテンプレートを使用する 

この例では、スタイルテンプレートを使用して Tecplot Chorus で使用する方法を検討します。 

Step 1  スタイルテンプレートを保存する 

スタイルテンプレートは プロットの外観を記録する Tecplot 360 の支持ファイルですが、データは含まれていませ

ん。このテンプレートを使用すると、別の調査のケースでも、すべて同じ標準的な外観で簡単にプロットを作成する

ことができます。 
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テンプレートを保存するには、プロットの右側にある Chorus サイドバーで、

Save Style Template ボタンをクリックします。Write Style File ダイアログを使

用して、ファイル （例えば “Xslice”） に名前を指定して保存します。 

デフォルトの場合、スタイルテンプレートは、プロジェクトのルー

トフォルダー内、 chorus によって生成された フォルダにある 

stylesheets フォルダに保存されます。このフォルダに保存された

スタイルテンプレートは、Tecplot Chorus のさまざまなダイアロ

グのドロップダウンメニューに表示されます。ブラウズせずに各メ

ニューにアクセスできて便利です。 

Step 2  複数のケースの比較 

作成したスタイルテンプレートを複数のケースの比較に役立てることができます。データを開いたとき、スタイルテ

ンプレートを指定することが可能で、Tecplot 360 を開いたときに、それぞれのデータファイルに適用されます。 

Tecplot 360 ウィンドウは開いたままで、Tecplot Chorus ウィンドウを前面に移動し、Table View の case ID 15 

をハイライトします。再度右クリックしてコンテキストメニューから  View Data を選択します。  

View Data ダイアログが表示されます。ドロップダウンメニューから Xslice.sty テンプレートをクリックしたら、

OK をクリックします。 

 

新規ページに case 15 が開かれ、スタイルテンプレートが適用されます。両方のケースが Tecplot Chorus サイド

バーの View Page セクターにリスト表示され、簡単に切り替えることができます。 

入力変数を表示するプロットにラベルを追加して、表示中のケースを識別しやすくしましょう。そのために、

Tecplot Chorus サイドバーの Label Frames セクションで、SO2 変数の South East (mph), North East (mph) 

および Mass Fraction を選択します。   
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結果のプロットが以下のように表示されます。 

 

Step 3  複数のプロットの表示 

Tecplot Chorus から、一度に一つずつ、ケースを開く場合、各ケースは Tecplot 360 の独自のページに表示されま

す。複数のケースを同時に開く場合には、すべてが Tecplot 360 の同じページに表示されます。 

この動作を確認するには Tecplot Chorus に戻り、Table View 内の最初の 3 つのケースを選択します。次にそれら

を右クリックして View Data を選択します。View Data ダイアログで、作成したテンプレートがアクティブである

ことを確認したら OK をクリックします。 

Tecplot 360 では以下のように表示されます。Chorus で選択したそれぞれのケースが独自のフレームに存在しま

す。 
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 Zoom and  Translate ツールを使用して、任意のフレームのビューをズームしたり、パン（移動）したり

することができます。すべてのフレームがズームされ、一緒に移動するのを確認することができます。 

ただし、一つのフレームで行った変更（例えば、等高線カラーの変更など）は、どれも他のフレームには適用されま

せん。特定のプロットの外観をハイライトする目的でスタイルを変更する可能性があるためです。すべてのフレーム

にスタイルの変更を適用したい場合は、変更した後に、 Tecplot Chorus サイドバー(Tecplot 360 内) の 

Synchronize Styles をクリックします。この機能は、アクティブなフレームからすべてのフレームに機能がコピー

されます。 

Step 4  データの違いを表示する 

Tecplot Chorus を使用すると、表示中のマスターケースと他のケースの違いを視覚的に表現することができます。 

 この機能は、同じメッシュを持つケースを比較している場合でのみ、正しく動作します。 

データ差分プロットを作成するには、マスターに指定したいフレームをクリック

し、Tecplot Chorus サイドバー (Tecplot 360 内) の下部にある Set Current 

Frame as Master ボタンをクリックします。 

3 つのフレームの真ん中をマスターフレームに指定して、今すぐ試してください。 

マスターを選択した後は Show Diff Data チェックボックスをアクティブにするこ

とができます。 

以下に示すように、非マスターフレームの下に、これらのフレームとマスターとの差分を示す追加のフレームが表

示されます。 
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差分フレームのすべてのデータ値は、マスターフレームのデータからデータを減算した結果で、新しい変数を作成し

ます。この値の変数は元の値と非常に異なる値を持つ可能性があるため、差分フレームには別のカラーマップを選択

することお勧めします。  

Tecplot 360 には、中央に 1 色、極値に向かって別の 2 色の陰影からなる、発散カラーマップが含まれています。

これにより、例えば、同じ白の領域、差分が正の赤の領域、差分が負の青の領域というように、領域を簡単に色付け

することができます。 

これらのカラーマップのいずれかを使用するには以下の手順に従います。 

• 差分フレーム内でスライスをクリックして、確実に差分変数を選択する。 

• Tecplot 360 の Plot メニューから、Contour & Multi-Color Details ダイアログを開く。 

• 例えば、カラー見本の下のメニューから、Diverging - Blue/Red のカラーマップを選択する。 

 

Contour & Multi-Color Details ダイアログを開いたままにします。 

• 比較するフレーム間で同じ値が差分プロットで白く見えるように、等高線の範囲を調整して確実にゼロを

中央にする必要があります。これを行うには、以下の手順に従います。 
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o Contour & Multi-Color Details ダイアログで Set Levels ボタン

をクリックします。  

Enter Contour Levels ダイアログが表示されます。 

o Exact Levels および Min, Max, and Number of Levels ラジオボタンが選択されていることを

確認します。 

o Minimum Level に -0.003、 Maximum Level に 0.003、Number of levels に 15 を入力しま

す。 

o OK をクリックします。ダイアログが閉じられ、新しい等高線レベルが作成されて Contour & 

Multi-Color Details ダイアログに表示されます。 

o Contour & Multi-Color Details ダイアログを閉じます。 

• Tecplot Chorus サイドバーの Synchronize Styles をクリックします。差分データに新しい変数が作成さ

れたので、これは他のフレーム内のスライスの外観だけに影響します。結果のプロットが以下のように表

示されます。 
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Step 5  イメージの生成 

保存したテンプレートを使用してイメージを生成することも可能ですが、基本的にケースの一部またはすべてのデー

タの特定のビューを前もってレンダリングします。 

特に、大きなデータセットを扱う場合、すでにデータから作成してあるイメージを表示するほうが、データ自体を開

くよりも迅速です。また、イメージをサムネイルとして使用して、Tecplot Chorus の Matrix View で視覚的にケー

スを整理し、アクセスすることもできます。 

次は、Xslice スタイルテンプレートを使用して、すべてのケースのイメージを作成しましょう。これを行うには、

Tecplot Chorus の Table View で、すべてのケースをハイライトします （ショートカット: Control-A -A for 

Select All).次に、右クリックして Create Images を選択します。 
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Create Images ダイアログが表示されます。このダイアログで Xstyle がスタイルテンプレートに選択されている

ことを確認し、OK をクリックします。  

Tecplot Chorus は Tecplot 360 に各データファイルをロードしてスタイルテンプレートを適用し、PNG イメージ

ファイルを保存するように指示します。これはバックグラウンドで行われ、作業が行われている間、どちらの製品も

使用し続けることができます。すべてのイメージが生成されると、Tecplot Chorus ウィンドウの下部にある、

Manage Jobs ボタンの緑色のドットでバッググラウンドのジョブが完了し、結果がデポジットされたことが示され

ます。 

 

Manage Jobs をクリックすると、Manage Jobs ダイアログが表示されます。 

 

Manage Jobs ダイアログでは、ステータスが Ready となっているバックグラウンドジョブを選択することができ

ます。次に Deposit をクリックし、イメージをプロジェクトに追加します。Append Data ウィザードが表示され、

新規イメージにタグ付けする方法を確認するメッセージが表示されます。 
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ここでは、デフォルトのタグ FileName-XSlice （元の CSV ファイルの列名に基づいてデータファイルが FileName

でタグ付けされ、適用されたスタイルテンプレートが XSlice であったということから生成された名前）を Xslice に

変更しました。各ケースに複数のデータファイルが存在しないため、タグを含める必要はありません。Next をクリ

ックして、Append Data ウィザードの最終画面に進み、Finish をクリックして、デポジット操作を完了します。 

Step 6  さらにスタイルを確認する 

このチュートリアルのダウンロードには、追加のスタイルテンプレートが含まれています。以下が含まれています。 

• BaseSliceSO2.sty 

• Pressure_top_3meter_offset.sty 

• stream_close.sty 

• stream_far.sty 

View Data または Create Images 機能を使用して試してみてください。 

2 - 5   イメージを使用して調査を詳しく見る 

調査の各ケースのイメージを生成したので、Tecplot Chorus でこれらのイメージを使用することができます。まず

は Matrix view で、次に、選択したイメージを表示して比較します。 

Step 1  マトリクスビューを開く 

Matrix View はイメージのグリッドで、行と列がプロジェクト内のメタデータ変数に基づくことを意味しています。 

Matrix View を開くには、  Tecplot Chorus ツールバーをクリックするか、View メニューから New Matrix 

View を選択します。例を以下に示します。 
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Matrix View の構成は、Properties サイドバーで制御します。このサイドバーは、Tecplot 

Chorus のすべてのサイドバーと同様に、ワークスペースの任意の場所にドッキングして、他のサ

イドバーを結合することができます （他のサイドバーで分割するか、タブを使用してスペースを

共有）、またはウィンドウ全体をドラッグして別の画面に移動することもできます。 

この例では、行に South East の風速変数、そして列に North East の風速変数を入力しました。それぞれの行の各

イメージは South East (mph) の特定の値を持つ複数のケースを表し、また、列と North East (mph) も同様の値

を持ちます。これらの変数に特定の値を持つケースがない場合、空白のセルがマトリクスに表示されます。 

Matrix View の右下にズームスライダーが用意されており、表示するケースの数を決めることができます。逆に詳細

をどのくらい表示するかも決めることができます。 

表示値を持つ複数のイメージが存在するため、ここで、各イメージに  小さな印が表示されます（しかし、この調

査における 3 番目の独立変数の差分値を伴います）。Page By を SO2 の Mass Fraction に変更すると、Matrix 

View は、この変数の各値に個別のページが提供され、サイドバーのスライダーを使用して選択することができま

す。これにより、シミュレーションの入力の有効値をざっと見ることが可能になり、アニメーションで結果に与える

影響を見ることができるようになります。試してみてください。 

Matrix のさまざまなセルをクリックして、サイドバーの Selected Image Values セクションに目を向けてくださ

い。 
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このビューの詳細についてはもう一度、Tecplot Chorus User’s Manual を参照してください。差し当たり、Page 

By を None にして、初期画面に戻します。 

Step 2  選択したイメージの表示 

Matrix View の左上のイメージを右クックし、View Images を選択します。Selected Image View が表示され、

行と列の変数と同じ値の共有により、マトリクスのセルに "スタックされた" すべてのイメージが表示されます（つ

まり、5 の South East (mph) と 5 の North East (mph) の両方を持つが、SO2 の Mass Fraction の値は異な

る）。 

 

Matrix Viewer 内で複数のセルを選択して、これらのセルに含まれるすべてのイメージを表示したり、List View 内

でケースを選択して、これらのケースに関連付けられたイメージを表示したりすることもできます。それぞれ異なる

ケース（および別の設定）からのイメージを伴って、任意の数の Selected Image View を開くことができます。  

Selected Image View 内のすべてのイメージは、一つのケースを表します。ちょうど Matrix View と同じように、

サイドバー内で選択したケースの変数値を見ることができます。このビューの詳細については Tecplot Chorus 

User’s Manual を参照してください。 
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Step 3  選択したイメージの比較 

Selected Image View を開くと、マスターとして指定するイメージを選択し、Properties サイドバーで Diff From 

Current ボタンをクリックして、差分画像を表示することができます。ここでは、最終ステップでマスターとして開

いた Selected Image View 内の最初の画像を選択しました。  

 

Image Difference ウィンドウは、先に見たデータ差分表示に似ています。生データではなく、レンダリングされた

イメージでのみ動作します。実際のデータより正確さは劣り、インタラクティブでもありませんが、既存の画像が存

在する場合は、さらに高速で、ケースごとにデータのどの領域が変化しているのかを素早く判断することができま

す。選択したケースの実データを比較して、これらの違いを更に検証することができます。 

2 - 6   新しい積算量を抽出する 

興味のあるすべての値がご使用のソルバーで計算されていないかもしれません。必要な結果を得るためにケースを完

全に再実行するのではなく、Tecplot 360 CFD 解析ツールを使用して、これらのケースを計算することができま

す。Tecplot 360 のマクロとして操作を記録することにより、すべてのケースを適用して、新しい値を従属変数とし

て Tecplot Chorus のプロジェクトに追加することができます。この方法は、個々のデータセットに補助データ値を

設定する、任意の操作で使用することができます。 

試してみましょう。サーフェス-具体的には地面-の SO2 濃度を統合し、Tecplot Chorus プロジェクトに追加しま

す。 

なぜ、地上で統合するのでしょうか？二酸化硫黄は空気より重く、マッチを擦ったような刺激臭があ

ります。施設から近隣に異臭を放ちたくないので、SO2 濃度を地表面で最小限に抑えたいと思いま

す。 
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Step 1  マクロの作成 

Tecplot Chorus に戻り、Table View 内で任意のケースを選択し、右クリックしてコンテキストメニューから View 

Data を選択します。View Data ダイアログで、 Style Template に None を選択したら、OK をクリックします。

Tecplot 360 にケースのデータファイルが開かれます。積分のマクロを記録する準備ができました。これを行うに

は、以下の手順に従います。 

• Tecplot 360 の Scripting メニューから Record Macro を選択します。Write Macro File ダイアログが

表示され、マクロに名前を付けて、保存するフォルダを選択することができます。 

• プロジェクトフォルダにある tecplot-derived フォルダ内の macrotemplates フォルダにマクロを保

存し、groundSO2.mcr と名前を付けます。 

macrotemplates フォルダにマクロを保存すると、styletemplates フォルダの動作と同様に、ドロ

ップダウンメニューにマクロが表示されます。このように、後でマクロを適用するときには、保存し

た場所を覚えておく必要はありません。 

• Analyze メニューから、Perform Integration を選択します。Integrate ダイアログが表示されます。 

 

• 上記のように、特に variable （#15, so2）および、zone （#11, ground）を設定します。そして、

Integrate をクリックします。 
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インテグレーションの結果が補助データのフレームに追加され、ここで、  Tecplot Chorus はこれら

をピックアップすることができます。(これらは単に情報としてダイアログにも表示されます。このダ

イアログは、すべてのケースに対してマクロを使用した場合は表示されません)。 

• 2 つの integration ダイアログを閉じて、Macro Recorder ダイアログで Stop Recording をクリックし

ます。 

マクロをすべてのケースに適用し、結果をプロジェクトにインポートする準備ができました。 

Step 2  変数の抽出 

Tecplot Chorus アプリケーションに戻り、テーブルビューですべてのケースを選択します（キーボードショートカ

ット Control-A)、右クリックして、コンテキストメニューから 変数の抽出 を選択します。Extract Variables ダイ

アログが表示されます。 

 

Macro ドロップダウンメニューから作成した groundSO2.mcr マクロファイルを選択して OK をクリックしま

す。  

Tecplot Chorus はすべてのケースにイメージを作成したときと同様に、バックグラウンドジョブとしての抽出をス

ケジュールします。終了している間、Tecplot Chorus および/または Tecplot 360 を使用し続けることができま

す。Tecplot Chorus ワークスペース下部の Manage Jobs ボタンに緑色のドットが表示されたら、それをクリック

し、 Extract Variables job を選択して Deposit をクリックします。Append Data ダイアログが表示されます。 
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このダイアログには、それぞれのケースで使用可能なすべての補助データが表示されます。必要なのは 1 つのみな

ので、残りはオフにします。 

• チェックボックス列の上にあるチェックボックスをクリックして、すべてのチェックボックスをオフにし

ます。 

• CFDA.INTEGRATION_TOTAL の横のチェックボックスをクリックしてオンにします。 

Tecplot Chorus 内の新しい変数に、さらに具体的な名前を使用するため、Display Name 列に GroundSO2 と入力

します。 

Finish ボタンをクリックします。プロジェクトの Table View で、新規変数が表示されているのを確認することがで

きます。 

 

2 - 7   Surrogate Model  (代理モデル) を使用して新しい変数を探索する 

新たに抽出した GroundSO2 の量がどのように動作するかの知見を得るため、surrogate model （代理モデル）を

作成することができます。代用モデルはシミュレーションに内在する物理モデルの数値近似で、まだ実行していない

ケースの結果を予測したり、外れ値を特定したり、最適化の研究をしたり、デザインスペースの関心のある領域を特

定したりするのに役立ちます。このチュートリアルのように比較的少ないケースの場合、代理モデルはデータの “形

状” (つまり、シミュレーションの入力と出力における関係) を把握するのに役立てることもできます。 

Surrogate Models（代理モデル） の詳細については、Tecplot Chorus User’s Manual を参照してください。 

北東風速および、Mass Fraction (質量分率) SO2 に対する GroundSO2 の 3D 散布図を使用して代理モデルを作成

します。これにより、計算した従属変数が、これら 2 つの独立変数とどのような関係があるのかが示されます。 
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Step 1  3D 散布図を作成する 

3D 散布図では、2 つの独立変数（一般に、1 つの主変数および、1 つあるいは 2 つ

の重要度が低い変数）に対して、3 つまでの従属変数を表示することができます。

散布図を設定するには以下の手順に従います。 

• View メニューから 3D Scatter Plot を選択するか、ツールバー内の 

 ボタンをクリックします。 

• Properties サイドバーで以下の軸変数を選択します。 

• X: North East (mph) 

• Y: Mass Fraction of SO2 

• Z: GroundSO2 

• Choose Color By Variable: GroundSO2 

その他の設定はデフォルトのままにして、 Surrogate Model の設定は無視します。プロットが以下のように表示さ

れます。 

ツールバーで  Rotate ツールをクリックして、3D 散布図内でドラッグして、視野角を変更します。深さの感覚

を得ることができますが、データが離れすぎているため、その形状を認識することは困難です。ここで代理モデルが

役立ちます。 

Step 2  代理モデルのトレーニング 

3D Scatter Plot ウィンドウをアクティブにして、Properties サイドバーの Surrogate Model セクションの 

Training ボタンをクリックします。Surrogate Model Training ダイアログが表示されます。 
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このダイアログで、目的の代理モデルの形式 (Quadratic Response Surface を使用) および、モデルに含める独立

変数を Tecplot Chorus に指示します(この場合、プロットでの軸として２つの独立変数)。 

• Quadratic Response Surface ラジオボタンをクリックします。 

• 使用可能な 3 つのすべての独立変数を選択し、Add をクリックします。 

16 のケースしか存在しないので、モデルのトレーニングは 1 秒しかかかりません。考慮するケース、および/また

は 変数が多い研究では、さらに時間がかかります。 

Step 3  代理モデルの表示 

Properties サイドバーの Surrogate Model セクションで Show チェックボック

スをクリックして、代理モデルを表示します。以下のように代理モデルが半透明、

薄い青色のサーフェスでプロット上に表示されます。 
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サイドバーに表示された R2 値に注意してください。この値は極めて 1 に近く、非常に良くフィットしていることを

示しています。 

Step 4  プロットしない変数に評価ポイントを設定する 

プロットに表示されたそれぞれのケースにおける North East (mph) および SO2 変数の Mass Fraction は代理モデ

ルへの入力です。しかし、3 番目の従属変数である South East (mph) は、このプロットで使用されていません。こ

の場合、代理モデルではこの変数のどのような値が使用されるのでしょうか? 評価ポイントを設定してこれを決定す

ることができます。 

プロットのポイントの 1 つを右クリックして、Set Surrogate Model Evaluation Point を選択します。Surrogate 

Model Evaluation Point ダイアログが表示されます。 



 2 - 7   Surrogate Model  (代理モデル) を使用して新しい変数を探索する 

 57 

 

このダイアログを使用すると、それぞれの独立変数に値を設定することが可能で、その変数がプロットで使用され 

ない場合に、これらの変数が使用されます。この場合、 South East (mph) のみが現在のプロットで使用されてい

るため、この変数に対する変更だけが代理モデルに適用されます。スライダーを移動し、それに応じて代理モデルが

どのように動くかを確認したら、最小値に戻して、ダイアログを閉じます。 

Step 5  モデルの出力を検査する 

回転ツールを使用して、別の角度からプロットを確認します。代理モデルをもとに設備の物理的な動作について何が

分かるでしょうか? 

• 予想どおり、SO2 の Mass Fraction と GroundSO2 の関係はかなり線形です。SO2 の放出が増すにつれ

て、最終的により多くの SO2 が地上に排出されます。 

• 風速と地面の SO2 の量にはわずかに非線形の逆相関があります。風の吹きこみが強くなるにつれて、設

備付近の地面近くの蓄積が少なくなります。 

これらの結果は妥当であり、予想通りです。 

Step 6  外れ値の検索と分析 

Z-軸を変数 downwind 25 （25 ヤード風下のポイントでサンプリングした SO2 濃度を表す）に変更します。何か

変化に気付きましたか? プロットを表示するには回転する必要があるかもしれません。 
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すべてのケースで入力変数と SO2 の風下濃度は非線形を示すことが予想可能で、それは代理モデルのサーフェスが

ほとんど平坦であることで実証されます。ただし、その１つのポイントは外れ値です。このケースを Tecplot 360 

で見てみましょう。 

• 3D 散布図で、不要なドットを右クリックします。(Tecplot Chorus では、すべてのビューで、ケース

（プロットを含む）を選択することができます) 

• コンテキストメニューから View Data を選択します。View Data ダイアログが表示されます。 

 

• None for Macro に None を選択し、 Style Template に Xslice.sty を選択します。 

• OK をクリックし、Tecplot 360 にケースを開きます。 

スライス面周辺のいくつかの流線にシード処理を行い、流線による新規スタイルテンプレートを作成してみてくださ

い。 

• Plot サイドバーにある Streamtraces チェックボックスの隣にある  ツールボタンをクリックしま

す。 
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• スライス上でラインをドラッグして、このラインに沿ってシミュレーションした無質量粒子をシード処理

します。Tecplot 360 が、これらの無質量粒子の流れを示す流線を描画します。 

新規スタイルテンプレートを保存し、すべてのケースに新規イメージを作成して、このケースの違いを明らかにしま

す。streamtrace を除き、このチュートリアルでは前にすべてを実行しました。 

Step 7  外れ値の削除 

この特定のケースは代表ではないと決定して、調査から外れ値を除外すると決定す

ることができます。3D 散布図で障害となっているドットを右クリックし、コンテキ

ストメニューから Mark as Inactive を選択します。不適切なドットがすべてプロッ

トから消去され、代理モデルで考慮されなくなります。 

Table View では case を見つけることは引き続き可能ですが、Case Status と呼ば

れる新しい列が作成され、 case (number 14) が非アクティブとしてマークされて

います。 

 

Table View の Properties サイドバーにある、Use Filters チェックボックスをチェ

ックして、Table View 内であっても、非アクティブなケースを非表示にしたり、

Filters サイドバーの下にある Case Status フィルターを使用して、非アクティブで

あってもすべてのビュー内でケースを表示したりすることができます。 

フィルターの詳細については、Tecplot Chorus User’s Manual を参照してください。 

2 - 8   次のステップ 

最初のチュートリアルでは製品概要を説明しました。本章では Tecplot Chorus の製品については多く触れませんで

したが、SO2 プルームの移行観察を例に、現実のプロジェクトで使用する機能を紹介しました。  

Tecplot Chorus のツールを実務で使用する方法を理解すれば、16 のケースであろうが、1600 のケースであろう

が、次の研究をより効果的に行うことができます。自分の研究からいくつかケースをインポートして、馴染みのある

データでこれらの手法を試してみることをお勧めします。 
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3 電動アクチュエータの最適化 

本章では航空機で使用されている電動アクチュエータの設計の最適化について説明します。以下を目指して設計しま

す。 

• 十分な力を生成する（得られるのであれば、より大きい力の方がよいとしても） 

• 重さとコストを抑える（使用する重くて高額なワイヤーと銅の量を最小限にする） 

• コンポーネント付近で遮断する必要がないように、磁気漏れの限界未満で保つこのチュートリ

アルでは散布図を使用して研究結果を可視化し、制約に合った設計を見つけます。 

このチュートリアル用のデータセットには 864 ケースのメタデータが含まれています。それぞれのケースにはデー

タファイルは含まれていませんが、シミュレーションの結果を表示する PNG イメージが含まれています。Chorus 

Getting Started Bundle をダウンロードすることができます。  

https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
https://tecplot.azureedge.net/data/ChorusGettingStarted.zip
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3 - 1   データセットの内部 

このプロジェクトは CSV（カンマ区切りフォーマット）ファイル、actuator_input.csv で提供されています。 

Step 1  Excel 内を検証する 

CSV ファイルを Microsoft Excel で開き、内容を確認してみましょう。 

 

上記はデータセットの一部です（CSV ファイル全体で、合計 866 行が含まれています）。L1 番目と 2 番目の行を見

ると、各フィールドの名前を持つ、通常の CSV ファイルです。オプションの Tecplot Chorus-特有のヘッダーは各

フィールドの種類を示しており、残りの 864 行はケースを示しています。ヘッダー行から、以下の存在を識別する

ことができます。 

• これらの独立変数 Z, Y および X はアクチュエータの設計パラメータを表しています。このチュートリア

ルでは、これらの値が実際に何を意味するかは重要ではありません。しかし、このケースのイメージを見

始めると意味が明らかになります。 

• シミュレーションによって次の 6 つの従属変数が計算されます: アクチュエータによって生成されたエネ

ルギー、アクチュエータのアマーチャの量、およびアクチュエータの構成に使用した 2 つの金属（銅とス

チール）の量、アクチュエータの磁気漏れ、およびその合計重量 

• タグ contours 付きの補助ファイル (PNG 画像)。 
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Step 2  Tecplot Chorus で開く 

Tecplot Chorus を起動して、プロジェクトを開きます。File メニューから Open CSV Project を選択し

て、用意されている CSV ファイルを Tecplot Chorus に開きます。.csv ファイルと同じディレクトリに

対する.chprj (Chorus Project) ファイルが作成されます。.chprj はプロジェクトに新規データを追加

するたびに更新されます。そのため、今後は .csv ファイルではなく、このファイルを開いてください。 

データの Table View が開かれます。 

 

プロジェクトには、すべての独立変数および従属変数とともに、CSV ファイルで見つかった 864 のケースが含まれ

ているのを確認することができます。各ケースのリンク画像の名前を含む contours 列だけば、テーブルに表示さ

れません。Tecplot Chorus はイメージを表示するとき、内部的にこれを使用します。それぞれのケースに割り当て

られている Case ID を確認することもできます。 

Step 3  設計パラメータについて 

Matrix View を使用すると、独立変数が示す内容を視覚的に理解しやすくなり、シミュレーションへの入力がどのよ

うに結果に影響するかを予想することができます。View メニューから、またはツールバーで  Matrix View ボ

タンをクリックして、Matrix View を開きます。 
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次に、Properties パネルを使用して Matrix View を設定します。このパネルは、デフォルトで Tecplot Chorus ワ

ークスペースの左側にドッキングされています。 

• Rows を Y に設定します 

• Columns を Z に設定します 

• Page By を X に設定します 

Matrix View の右下隅にある Zoom スライダーを使用して、個々のサムネイルのサイズを調整し、20 くらいのサム

ネイルが見えるようにします。 

Page By スライダーを使用して X の値を変化させて確認します。スライダーを移動するにつれて Matrix View 内の

サムネイルが変わります。フリップブックスタイルアニメーションを使用すると、独立変数 X が、アクチュエータ

の幅 を表していることが即座に分かります。 

同様に、垂直または水平にスクロールすると、Y または Z が設計に与える影響の内容を見ることができます。Y は

アクチュエータの高さです。Z の増加は磁場の強度の増加に相関があります。すなわち、Z はアクチュエータの設計

の奥行または厚さであり、X および Y について分かっていることに一致します。また、従属変数への効果とも一致し

ます。 
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独立変数が変わるにつれて変化するサムネイル内の色の動向にも気付くかもしれません。 

イメージに凡例があるように見えます。確認してみましょう！任意のサムネイルを右クリックして、コンテキストメ

ニューから View Images を選択します。選択したケースからのイメージとともに Selected Image View ウィンド

ウが表示されます。このウィンドウで Zoom スライダーを調節すると、凡例を詳細にみることができるようになり

ます。 

 

凡例から、最も強い磁場に関連付けられた赤い色を確認することができます。そのため、一般的に言えば、イメージ

に赤い色が増えるほど、その設計で磁場が強くなると解釈することができます。この知識を持って、Selected 

Image View ウィンドウを閉じることができます。そして、 Matrix View 内のサムネイルをざっと確認すること

で、各アクチュエータの設計で生成された磁場の強さと、各入力変数がこの特性にどのように影響を与えているかの

概要を素早く判断することができます。 

最後に Matrix View の各ページで 8 つのケースの 9 つの行、または合計 72 のケースが示されることを確認しま

す。プロジェクトにおけるケースの合計数の 864 を 72 で割ると、ちょうど 12 となります。これは、すべてのパ

ラメータの離散値のすべての組み合わせにケースが存在することを強く示唆しています。これは ”スパース” プロジ

ェクトではありません。”欠落” またはシミュレートされていないケースはありません。  

そのため、ズームを設定して各ページですべての 72 のケースを表示できるようにし、Page By スライダーを使用し

て X の値を変化させます。すべてのケースにサムネイルがあり、この調査では X の離散値が 12 あることがすぐに

分かります。 
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行または列を交換して、X を表示し（Page By 変数を None に設定）、 X の離散値をそのようにカウ

ントすることもできます。 

Matrix View を使用して、データセットについて多くのことを学びました。しかし、このビューを使用するだけで

は、どのケースが設計目標を満たしているかは分かりません。 

3 - 2   制約の可視化 

制約を可視化するとフィルターを使用して調査のどのケースが設計の成功基準を満たすかを確認することができま

す。まずは、Tecplot Chorus の View メニューまたは、ツールバーで  2D Scatter plot ボタンをクリックし

て、2D Scatter Plot を開きます。 

Properties サイドバーで、X Axis を Weight に設定、Y Axis を Fy に設定し、Coloring セクションで Color by 

Filter Violations を選択します。最初のプロットが以下のように表示されます。 

 

上記の画面キャプチャでは、Filters サイドバーをワークスペースの右側にドッキングしました。この

サイドバーは幅広く使用されます。Properties および Filters のどちらにもアクセスできることが便

利な場合がよくあります。どのサイドバー・パネルもワークスペースの任意の側にドッキングするこ

とができます。また、Tecplot Chorus のメインウィンドウの外に完全にドラッグして第二の表示にす

ることもできます。 
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このプロット内のすべてのドットが調査のケースを示しています。調査内のケースは選択可能で、右クリックすれば 

Table View、Matrix View ほか、Tecplot Chorus におけるすべてのビューと同様にイメージを開くことも可能で

す。1 つのビューで選択したケースは、すべてのビューで選択されます。  

ケースを選択するだけで、一つあるいは複数のケースに関連付けられた値を確認することができます。ワークスペー

スの下にある Selected Cases パネルには、これらのケースの変数だけが表示されます。（このパネルが開いていな

い場合は、View メニューから開くことができます）。選択したケースだけを表示する場合を除き、Table View と

同様に動作します。 

 

プロットの網かけ部分は、Filters サイドバーで追加した制約外の領域を示しています。これらの制約をまだ定義し

ていないため、プロット内のすべての調査が網かけ領域外（または、制約のない白色の領域）にあり、個々のドット

はすべて緑色です。（選択したケースは濃い 緑色です） 

どの設計が目標の基準に合致するか決定したいので、主に従属変数のフィルタリングに興

味があります。Filters パネルを管理しやすいように、他の変数を非表示にしましょう。 

Filters サイドバーの上部にある歯車アイコンをクリックし、ドロップダウンメニューか

ら Select Filters to Include  を選択します。Select Filters to Include ダイアログが表

示されます。 
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このダイアログで Independent および Other グループのチェックを外し、OK をクリッ

クします。Filters サイドバーに従属変数のフィルターのみが表示されます。 

ここで、基準に合わないケースを除去するフィルターを設定します。まずは、Weight フ

ィルターが  0 から 1.95 （最大制限重量）のみを表示するように設定します。次に、

Force が 22 以上のケースだけを表示するように設定し、最後に Leakage を 0.01 未満

に設定します。目的の Filter 設定が右側に表示されます。 

以下は 2D 散布図での、これらフィルターの結果です。 

 

この調査では、ほとんどのケースが網かけ領域に存在しており、ほとんどの設計が重すぎたり、十分な力を作り出し

ていなかったり、磁気漏れが多すぎたりすることを示しています。赤のドットは、これらの基準の 2 つ以上に反し

ているケースを示しており、青のドットは 1 つの基準に反しているケースを示しています。白い部分の右下隅が関

心領域です。これらの設計のいずれかは基準に適合していますか? すべての基準が満たされているケースを表す緑の

ドットがあるかどうかを確認するのは困難です。拡大してさらに詳しく見てみましょう。 

• Tecplot Chorus ツールバーで  Zoom （拡大）ツールを選択します。 

• 2D 散布図で関心のある領域の周囲を四角くドラッグします。「許容範囲」 と  

「許容範囲外」 のラインの境界が確認できるように、網かけ部分の一部を含め

ます。 

拡大すると、役立ちそうなケースを示す緑のドットがいくつかあることが分かります。4 つ、厳密には 1 つの正確な

重量制限が許容範囲であると仮定します。 
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銅は高価なので、別のフィルターを追加して、設計で使用する銅の量が 3.5 未満となるよ

うにしましょう。この規則はケースを 1 つ除外します。白い領域の最上部のこれまで緑だ

ったケースが青になりました。さらに、以前は青だった多くのケースが赤に変化し、これ

らのケースが銅の制約に反していることを示しています 
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役立ちそうに見える 3 つのケースがあります。緑のドットをすべて選択します。 

• ツールバーで  Select （選択）ツールを選択します。 

• 2D 散布図の緑のドットのいずれかをクリックします。 

• Control キーを押しながら 2 番目と 3 番目のドットをクリックします。 

右クリックして、コンテキストメニューから View Images を選択します。条件に合った、3 つのアクチュエータと

ともに、Selected Image View ウィンドウが表示されます。 
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どのイメージがどのケースでしょうか? ラベルを追加しましょう。Properties サイドバーで Select Labels ボタン

をクリックして、 Labels Images ダイアログを開きます。 

 

このダイアログで Case ID, Z, Y, X, Fy および Weight をオンにしましょう。 

 

OK をクリックして Label Images ダイアログを閉じます。次に Properties サイドバーで Show Labels チェック

ボックスをオンにします。各ケースの下の Selected Images View ウィンドウにラベルが表示されます。 

 

これらは機能する 3 つの設計です。これらすべてをレポートに含めます。 

しかし、以下に示すように１つが明らかに他よりも優れています。 



 3 - 2   制約の可視化 

 71 

 

この設計は、その重さに対して必要以上の優れた力を生成し他の方法よりも軽量です。またこれは、限界に達してい

ないため若干 “余裕” も残されています。その他、より多くのエネルギーを生成する唯一の設計は、正確な重量制限

です。また、もし航空機で他の設計を選択して制約が厳しくなると、恐らく最初に仕様から外れます。 

そのため、指示された設計をお勧めします。右クリックして、View Images を選択します。拡大して、ラベルをオ

ンにします。 
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これです。もし、このケースにデータファイルがあれば、これを Tecplot 360 で開くことができ、詳細で高品質の

プロットを作成することができます。 

3 - 3   次のステップ 

これまでの 3 つのチュートリアルで Tecplot Chorus の主要な機能を検討してきました。 

• Table View および Matrix View 

• 2D 散布図、3D 散布図、および Line(ライン) /Symbol (シンボル) プロット 

• Selected Items パネル 

• フィルターおよび制約の可視化 

• 個々のケースからのデータの可視化と比較 

• イメージの表示と比較 

• スタイルテンプレートとイメージの生成 

• 新しいメタデータ値の抽出 

これで独自のプロジェクトで Tecplot Chorus を使用する準備ができました。取りかかりましょう! 


